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[A] 5Vdc isolated
supply IN RF Outputs

1. Hardware Connections.

e Minimum Connections:

- USB I/ Ill or Gb Ethernet to host PC. (Ethernet not used on the iMS4-L variants )
- DC Supply, 15V(min),2A to 24V(max),1A
- One or more RF outputs J1....J4, as required. Terminate with 500hm load.

e Optional connections, identified as follows in the diagram above:

E] = hardwired control signals from external signal source(s).
Functionally equivalent software generated control signal are provided in the SDK.

[1] = opto-isolated 10 buffered signals requiring an external 5Vdc supply connection to either J7 or J8

[A] = external power amplifier connections (see explanation below)

The iMS4-P provides external power amplifier diagnostic and control signals via J5.

This is an opto-isolated interface and requires a 5Vdc feed (5V_RFA) supplied from the connected RF
amplifier. An appropriate interface card must exist within the power amplifier.
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2. Software

ISOMET »

Home

Home/Support

Download the iMS software from

http://www.isomet.com/software.html|

Application Notes

Software iMS4:
Depending on your computer, select iMS4 Lookup Tables —
. iMS4 Support ?

and run one of the following: e e

Isomet iMS4 GUI Software Guide rev 1.45¢ (PDF)

Isomet iMS4 LUT Generation
Isomet iMS SDK v 1.xx Win7 Setup.exe S
Isomet iMS SDK v 1.xx Win10 Setup.exe
Supporting documentation is provided at W

ISOMET»

http://www.isomet.com/ims4support.html| o

Home/Support

Application Notes

Software

iMS4 Lookup Tables iIMS4-L Overview and Basic Operation_revB_1.4.6
iMS4 Support iMS4 GUI Software Guide V1.6.0

Manuals iMS4-P(revB) iMPA4 (LS110XY) Connection Guide

iMS4-P(revB) RFA 0110-4 Connection Guide
iMS4 Basic Set Up Guide Single Axis AO
iMS4 Compensation LUT Guide - Rev-B
iMS4 Compensation LUT Guide - Rev-C
iMS4 Sequence Tables

IPConfig App

iMS4-P Overview and Functions_revB_1.4.8

iMS4-P Overview and Functions_revC_1.5.1

3. Apply DC power.

A mating connector is provided.
15V(min),2A to 24V(max),1A

+15V to +24Vdc

Initializing and LED indicators Viewinto iMS Vde connector

All LEDs on the iMS4-P will illuminate briefly
on initial power up.

An automatic boot sequence then follows;
read internal flash, initialize peripherals,
request Ethernet DHCP * and USB power

up.

Once initialization is complete, the upper
red LED’s will remain illuminated and the

two green LED’s will beat synchronously at
~1Hz rate.

(*DHCP request times out after ~10sec if not connected and reverts to the default static IP of
192.168.1.10. It can be reassigned).


http://www.isomet.com/software.html
http://www.isomet.com/ims4support.html
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4. Connect USB or Ethernet
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It is recommended that the USB or Ethernet lead is connected to the iMS4- prior to power up.

Only attempt software communication AFTER initialization is complete.

If the GUI is not closed .

"8 Windows Task Manager

File Options View Help

correctly, crashes or will not

Applications | Processes |Servioes I Performance INetworhng I Users |

open, then please use

W| n d OWS Ta S k M an age rto Image Mame User Name CPU  Memory (... Descn;:non

R . Isomet M3 Studio.exe *32 Mike [ali} 50,400 K IsometiM...

d e | ete t h e Isomet IMS stud’o ims_hw_server. exe =32 Mike i} 7,000K  ims_hw_s...
infriray Ave Milee nn 298K inFeTrav

and ims_hw_server processes.

5. Does myiMS work ?

Run the Isomet iMS Studio, e.g. click the desktop icon

a)

Isomet iMS
Studio

A new Project Window will open

) Isomet iMS Studio v13.0.10
File Edit Window Tools Help

Y= .3 X0

Project Explorer
Image Groups / Free Images

..

Enhanced Tone New Image X

5]
New Image (2 entries) : Chi Frequency (MHZ Chl Amplitude (%) Chi Phase (deg) ~ Ch2 Frequency (MHz) Ch2 Amplitude (%)  Ch2 Phase (deg)  Ch3 Frequency (MHz) Ch3 Amplitude (% Ch3 P
+
Wl © 00000 [ 0.0000 [ 00000 [ 0.0000 [ 00000 [ 0.0000 [ 00000 [ 00000 [
w 1 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
Compensation Functions
Name Entries -
»
Tone Buffers =
Name -
»
Number of Image oints: | 251 Defauit Intemal Clock Rate (et | 100000 5] Defauit External clock Divider: | 1]

Hardware Concale

Select Calibration (Single Tone) Mode

B
3
- x
Calibration vaXx
10000MH  00/% 0.0|de

We will use the Calibration (Single Tone) mode as a simple method to check the basic functions and

prove communication with the Host PC.

This mode will generate a constant RF signal on all RF output channels; J1...J4.

There is no sync output on J7 in this mode (SDIO-n)
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Select Calibration Tab
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Select the - button. It will change to - and the RF outputs will be active.
Adjust the Frequency and Amplitude sliders as required.

Note: This mode will prevent Image Play. Return to - when finished.

Calibration

HOLD |I|

100.00 MK

Frequency

H Amplitude

0.0 %

* X

Sig... Co...

Cal.. Pla..

0.0 de¢

Calibration

120 MHz

Frequency

Amplitude

776 %

> QX
0.0|deg

Phase

I
(=]
=
=]

| N N |

———

Signa...

Calibr..

Playe...

Com...

At 100 % amplitude, the RF output on J1, J2, J3 or J4 will be ~10-700mV peak to peak into 50 ohm,
depending on the Signal Tab settings (see Section 9)

Typical output levels at 110MHz, V peak-peak voltage, 500hm termination

DDS Level

0%
10%
20%
30%
40%
50%
60%
70%
80%
90%

100%

10%
0.006
0.008
0.008
0.008

0.01

0.01

0.02

0.04

0.07

0.09

Ch1, Ch2, Ch3 or Ch4 level / Ext’l modulation Level

20%
0.014
0.016
0.016

0.02

0.03

0.04

0.05

0.08

0.13

0.17

30%
0.032
0.036

0.04

0.05

0.06

0.07

0.09

0.13

0.19

0.24

40%
0.07
0.08
0.082
0.09
0.1
0.12
0.14
0.18
0.25
0.32

50%
0.11
0.12
0.13
0.14
0.15
0.17
0.19
0.23
0.3
0.39

60%
0.16
0.17
0.18
0.19
0.21
0.23
0.25
0.29
0.36
0.46

70%
0.21
0.22
0.23
0.24
0.26
0.28
0.3
0.34
0.41
0.54

80%
0.25
0.26
0.27
0.28
0.3
0.32
0.35
0.39
0.47
0.6

90%
0.27
0.28
0.29
0.31
0.33
0.35
0.39
0.44
0.53
0.66

100%
0.28
0.29
0.31
0.33
0.35
0.38
0.42
0.47
0.57
0.73
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6. Running the example Isomet iMS Studio Project(s)

- Load Example Project
Go to Tool bar > File > Open —
Se|ECt example prOJGCt file *~ipp 1 M > Dropbox > iMS-Studio-data > D1384-aQ120
and open. New folder

I D1384_100-140M_swp_100%A.ip 13/09/2018 1244 IIPFile

File name: (D1384_100-140M_swp_100¢

In this case we select the file; D1384_100-140M_swp_100%A.ipp

This IMAGE file generates a linear frequency ramp followed by an OFF period. It comprises of 120
image points with the same data on all four iMS4 channels. Points 1-100 are programmed with the
100-140MHz sweep at 100% amplitude. Points 101-119 are at an arbitrary frequency (131MHz) and
0% amplitude.

The Sync Data (Dig) field, is programmed with 0x0001 expect for 5 point around the mid-scan
frequency (120 — 121 MHz). Use the L<-> R slider bar to display. The Sync Data outputs are inverted
at the output J7. This data will give a logic high signal to indicate the mid-scan position

The GUI window should look like this:

M)) Isomet iMS Studio v1.3.0.1054 [C:\Users\mikeH\Dropbox\iMS-Studio-data\D1384-aQ120\D1384_100-140M_swp_100%A.iip] - X
File Edit Window Tools Help

= .3 3. X0 ®.
Project Explorer 00-140M swp X Enhanced Tone Signal Path
Image Groups / Free Images = Power Settings
100-140M swp (120 entries) : Ch1 Frequency (MHz) Chi Amplitude (%) Chi Phase (deg) Ch2 Frequency (MHz) Ch2 Amplitude (%) | Ch2 Phase (deq) Ch3 Frequency (MHz) | Ch3 Amplitude (%) Ch3 F 25 [s0. [ s0. [ s0. [ s
Tl 100.0000 100.0000 0.0000 100.0000 100.0000 00000 1000000 100.0000
K 100.4000 100.0000 0.0000 1004000 100.0000 00000 1004000 100.0000
2 100.8000 100.0000 0.0000 100.8000 100.0000 0.0000 1008000 100.0000
3 101.2000 100.0000 0.0000 1012000 100.0000 0.0000 101.2000 100.0000
4 101.6000 100.0000 0.0000 1016000 100.0000 0.0000 101.6000 100.0000
5 102.0000 100.0000 0.0000 1020000 100.0000 00000 102.0000 100.0000 o ch: cha
6 102.4000 100.0000 0.0000 10244000 100.0000 00000 1024000 100.0000 e
7 102.8000 100.0000 0.0000 1028000 100.0000 00000 102.8000 100.0000 ot It I It
8 103.2000 100.0000 0.0000 1032000 100.0000 00000 103.2000 100.0000 bos
9 103.6000 100.0000 0.0000 1036000 100.0000 0.0000 103.6000 100.0000 [l Ampitier Enabe
10 104.0000 100.0000 0.0000 1040000 100.0000 0.0000 1040000 100.0000 [ 7 Chaneis 12 Enable
11 104.4000 100.0000 0.0000 1044000 100.0000 0.0000 104.4000 100.0000
12 104.8000 1000000 0.0000 104.8000 100.0000 00000 104.8000 100.0000 il e channets 344 Enavte
13 105.2000 100.0000 0.0000 1052000 100.0000 00000 105.2000 100.0000 Sync Data Settings
Compensation Functions e 105.6000 100.0000 0.0000 105.6000 100.0000 00000 105.6000 100.0000 Analog Sync Output Source A
hame|Entries : 15 106.0000 1000000 00000 106.0000 100.0000 0.0000 106.0000 100.0000 jEo=inzlog)) -
|16 106.4000 100.0000 0.0000 106.4000 100.0000 0.0000 1064000 100.0000
17 106.8000 100.0000 0.0000 106.8000 100.0000 00000 106.8000 100.0000 Analog Sync Output Source B
18 107.2000 100.0000 0.0000 107.2000 100.0000 00000 107.2000 100.0000 ImageAnalogh .
19 107.6000 100.0000 0.0000 107.6000 100.0000 00000 107.6000 100.0000
Digital Sync Output Source
20 108.0000 100.0000 0.0000 108.0000 100.0000 00000 108.0000 100.0000 i s
21 108.4000 100.0000 0.0000 108.4000 100.0000 00000 1084000 100.0000
Tone Buffers 22 108.8000 100.0000 0.0000 108.8000 100.0000 0.0000 1088000 100.0000 T Y
Name o= 109.2000 100.0000 0.0000 109.2000 100.0000 0.0000 1092000 100.0000
L 109.6000 100.0000 0.0000 109.6000 100.0000 0.0000 109.6000 100.0000 000 s
25 110.0000 100.0000 0.0000 1100000 100.0000 00000 1100000 100.0000 Digital Sync Pulse Length
26 110.4000 100.0000 0.0000 110.4000 100.0000 00000 1104000 100.0000 [ Enabled
nn ns
Number of Image Points: | 120[%]  Default Intemal Clock Rate (cHz): | 166.000[5] ~ Default External Clack Divider: = So.. Cal. Pa. Con

Hardware Console

/'

Internal Clock rate
Tabs: Signal Path Player

Calibration Compensation
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7. Select Compensation Tab

Click on Import Button
Open the required *.LUT files

Name

W 20-220M_100%A Oph.lut
I RvC 374nm100-140M-D90Ch50-A.LUT

»
ownloads A

ocuments

File name: 374nm100-140M-DS0ChS0-A

LUT File
LUT File

LUT file size = 57KB is a Global compensation file that applies the same data to ALL outputs of the
iMS4. (This is the only option for older Rev-A and Rev-B of the iMS4 Synthesizers).

LUT file size = 225KB is a Channel scoped (channel specific) compensation file that can apply unique
values to each channel. This is the recommended LUT option for X-Y deflector use.

In this example we will open:

RvC 374nm100-140M-D90Ch50-A.LUT

[This Compensation file generated for a D1384 at 374nm.
100-140MHz freq’ range using a RFA0120-4-15 amp. iMS4
Power Settings DDS=90% , Chn=50% (See Signal tab)]

The graphic will show a plot of the
compensation response

Make sure Global box is unchecked

Click Download

Sync Data (Dig)

Sync Data (A1

0x0001 0.00(
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.001
0x0001 0.00(
0x0001 0.001
0x0001 0.001
0x0001 0.00(
0x0001 0.00(
0x0001 0.001
0x0001 0.00¢
0x0001 0.00¢

Compensation X
Amplitude Compensation

1003
3 -~ Cht
903 ~~ Ch2
E ~ Ch3
80 ~ Ch4
70
# 603
W E
= E
2 50
=
< 403
305
205
10
0
‘|l|||||||I|||||||||I111||||||I||||'|||ll[r||||l
] 50 100 150 200
Frequency (MHz)
O Phase
O Analog LUT O Digital LUT
Channel Scope XY AOD
[] Global Synch Phase Pairs
Import / Export
| Import ‘ | Export | WD

Signal...  Calibrat.. Player.. Compe..
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8. Select Player Tab Player Configuration “Ex
= Image Clock Source
Sync Data (Dig) ~ = ~
] ) :W @Intemal O External
This example will use the Internal clock source and 1 ooom Image Trigger
H H H 0x0001 @® No Trigger O External
No Trigger with repeated image play (Repeat Forever). T oo Ol - Bxtemal
T oxooot O Host O Delay
0x0001
Image Repeats
Internal clock rate is set on the lower tool bar, main window %} Repeat Forever I
: 0x0001 Post Image Delay
0x0001
For external signals , check External buttons and apply: T oo 00l ms
. . 0x0001
- Trigger input to J10 ] 0x0001 External Clock Polarity
g8 p i
_ Clock |nput to .]11 B gggg;‘ @ Normal (L-H) O Inverse (H-1)
iﬂ External Trigger Polarity
i 0x0001 ® Normal (L-H) O Inverse (H-1)
Note: If you do not want to use a compensation *.LUT file == oot ——
oxooeT nable Com
(see previous section) , then uncheck these highlighted T owoont Ampitude R2) Phase
. . 0x0001
boxes to disable compensation. T oo
1 00001
B 0x0001
The RF output will be zero unless a *.LUT file is downloaded s
into the iMS4 or these boxes are unchecked. 1 oo

Signal... Calibrat.. Player. Compe...

When using a RF amplifier with connection to iMS4 connector J5:

For BOTH Internal and External signals apply:
- Gate input to J9 (Logic high — ON)

Check Amplifier Enable button
(Red -> Green)

J5 to RFA

Signal Path v iax
- Power Settings /
78. | 50. | 5 50. 50

1 Ch2 Ch3 Ch4

|

Int Int

ﬂ Amplifier Enable

E RF Channels 1+2 Enable
E RF Channels 3+4 Enable

Sync Data Settings
Analog Sync Output Source A
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Select Signal Tab Signal Path > X
Power Settings

Two Power Settings control the RF output level: 82. | 53. | 53. | 49. | 49.

- DDS is common to all four outputs. C:DGD

- Chl1, Ch2, Ch3, Ch4 sliders set the

power for each output channel Ch1 Ch2 Ch3 Ch4
independently. | — ——
Int Int Int Int
DDS
Typical settings when used with RFA0110-2-15 are: ™ Ampiifier Enable
= o/ _ 0
DDS =70% - 90% ld RF Channets 1+2 Enable

Chl =Ch2 = 40% - 60%

Ch3 = Ch4 = 40% - 60% i RFChannets 3+4 Enable

Sync Data Settings
Analog Sync Output Source A

For XY AOD applications, Chl = Ch2 and Ch3 = Ch4 ImageAnalogA 9

iMS4 RF OUtpUt connectors. Analog Sync Output Source B
Terminate in a 50ohm input or load. ImageAnalogB

Digital Sync Output Source

J1=Chl ImageDigital B
J2 =Ch2,
J3 =Ch3 Digital Sync Output Delay
J4=Ch4
000 s
Digital Sync Pulse Length
[] Enabled
nn e
Sig... Cal... Pla... Co...

9. Start Image Play

Click the Play Button to start Image play.
(It will ‘grey’ out).

B lsomet iMS Studio v1.3.0.1054 [CAUsers\mikeH\Dropbox\MS-Studio-d

file Edit Window Tools Help
N Q o 0 e.
’roject Explorer T00-140M swp X Enhan%e
Image Groups / Free Images i
100-140M swp (120 entries) 5 Phase (deg) Ch3 Frequency (M}jl) Ch3 Ampﬂfude (%)  Ch3 Phase (de
s | 00000 102.0000 100j0000 0.000C
6 | o00gef 1024009 100000 0.000¢
7 fo0o 1028060 1004000 0.000¢
8 ¢ 00000 103,000 1000p00 0.000¢
0.0000 194.6000 100. OQUD 0.000C
10 | 00000 f04.0000 100000 0.000¢
1 00000 104.4000 1000080 n.oo0c
Start Stop at Image end Stop Immediately

(Check: Repeat Forever is selected, Section 8)
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Typical output waveforms on oscilloscope for the files and signal levels described above.
For an Internal Clock rate = 166KHz

Trace 1 = RF output (500hm terminated); J1, J2

Trace 2 = SDIO-0; J7 pin 33, (rtn pin 26)

00y @ @) 5.0 B T 100MS’s @ 7 [22Mar 2021
100k points 3.40Y )l 18:21: 04
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The same settings and Image files with Compensation Disabled Rlaysgionfigucation R
= Image Clock Source

= ® Internal O External

— Image Trigger

@® No Trigger O External

) Host O Delay

Image Repeats
‘ Repeat Forever "

=]
157

Post Image Delay
[ oof] ms

External Clock Polarity
® Normal {L-+ O Inverse (H-L

External Trigger Polarity
® Normal {L-+ O Inverse (H-L

b Compensaion
W00mv @ 2 B L00MS /s 7T
100k0ints 3.40 Y ]

e

Sig.. Cal.. Pla.. Co..

10. Connection for SDIO-0 signal and return

View into iMS4 connector J7
SDIO outputs are opto- isolated and require a separate +5V supply to operate

+5V iso  Gnd_iso
(20) (16)

15

oooooooooo 0000
30C> o000 ooooo coo 16
cooffooooooo0poo

7 /“

(33)
Rtn_lso SDOR 0

View into iMS J7 connector

10
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11. Documentation and Hardware Revision

W . .
) Isomet iMS Studio
Image Generator and iMS System Control Application

- To check the SDK and iMS4 build revisions: ferfen 136108

Wgy Copyright © 2020 Isomet (UK) Limited. All Rights Reserved.
)) hitp://wwwisomet.com/

Go to Tool bar > Help > About

Component Version
iMS Studio App 130.1054

iMS Library 182

HW Server App 12188

HW Server Library 182

Synthesiser iMS4c 3290
Controller iMSP 2.1.67

- For Isomet SDK documentation
Isomet Modular Synthesiser (iMS) API 170

iMS APT

Go to Tool bar > Help > iMS Documentation

e

|
iMS Library and APl Documentation

Contents

« Overview

« What's Included
i Seiping Y| . Platform

o

- Software Library Architecture

- .NET Wrapper

- Python Wrapper

- IMS Hardware Server

- IMS Studio

- Tutorial 1(a): Setting up a project and connecting to an IMS
- Tutorial 1(b): Programming and Playing an Image

- Tutorial 2: Using the API Message Handling System

- Glossary

- Release Notes

Bug List
» Namespaces

Overview

The IMS (somet Modular Synthesiser) System represents an expansive range of hardware devices and software inte
integration of Acousto-Optic (AO) technology into end-user systems.

- To check software actions andiMS4 hardware status/response:

Click on Hardware Console lower left of main GUI window

3 Isomet iMS Studio v1.

55 [New Image Project]

—lelx]|
He Edt Window Tools Help
o SOpiE 3.X,0 Cro?
= E Bl - -] -]
Project Explorer New Image X Enhanced Tone ol
—Image Groups / Free Images —Power Settings
¥
Rewiinag= (Zenkaes] i [cht Frequency (MHz) |Chi Amplitude (%) | Cht Phass (deg) |Ch2 Frequency (Mrz) |Cha Amplitude (%) |Ch2 Phase (deg) |ch3 Frequency (M) = | [ 25 [50. [50.
* > 0.0000 [ 0.0000 [ 0.0000 | 0.0000 [ 0.0000 [ 0.0000 ER I
‘, 1 00000 0.0000 | 0.0000 | 0.0000 | 0.0000 [ 0.0000 [ 0.0000 :
Sowrowz
= Amplitude Control Source
| Wiperl ~
Dos e
W Amplifier Enable
- RF Channels 1+2 Enable
- RF Channels 3+4 Enable
Sync Data Settings
' Compensation Functions ———————— Analog Sync Output Source A
o e —( imiiot e
.| Analog Sync Output Source B
ImageAnalogB hd
Digital Sync O it Source
ImageDigital hd
e iaital Sme Outout Delav
Hardware Consale: - ax
T et Dis TERETT OUSTISST WIRST TSI WIpST ITSUT SToSRIRERT |
(1% Set symemromous Outpuc Delsy: Oms. Pulfed = 0
[5]: Master Switch Ensble: Amplifier (Dissble] RF Channel 1/2(Dissble) RF Channel 3/4(Dissble] Excernal Eqr(Dissble]
110]: Sev Symchromous Output Mapping: Imagehnalogh <==> inalogh
{11]: Set Synchromous Output Mapping: Imagelnalogd Znalog
{12]: Sev Symchromous Outpus Mapping: ImsgeDigital <==> Digital
[13]: Sev DDS Pewer: DDS(25%) Wiper 1(50) Wiper 2(50) See=WIPER 1
1141: Sev Svnchremcus Ousew Delav: ns. Pulssd - 0 =

Hardware Censole

@ Document1 - Microsaf... “» Isomet iMS Studio .. A @ Oy 19/11711122;19 =

To expand this view, select the Down Arrow at the top right bar of the Console window
and select : Dock as Tabbed Document

11
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12. Trouble Shooting Log File

In cases of difficulty and when seeking Isomet support, it can be helpful to generate a log file.
The log files will need to initiated. This is the default condition.

Check the system.ini file has been correctly loaded and active. This is automatically installed with
SDK. Typical location:

C:\Users\<username>\AppData\Local\lsomet\iMS_SDK\settings.ini

Open the system.ini file with Notepad and check the first few lines of text

o — e .= BN N —  _E e T
| settingsini - Notepad =8 =
File Edit Format View Help
# Lug?‘ing core settings section. May be omitted if no parameters specified within it. -
[Core

DisableLogging=false
Filter="%5everity® »= trace"”

# sink settings sections
[5inks.LogFile]

# sink destination type
Destination=TextFile

# The file name pattern for the sink backend. Include an absolute path to specify which folder to place
# the log file into. If no path is specified, the log will go into the users’ tem

# directory (on windows, typically (:\Users\<usermame>\AppData\Loca1\Temp, on *nix, "/tmp")
FileName="C:\Users'Mike'AppData‘Local‘\Temp'imslog_%5N. Tog"

# sink-specific filter. optional, by default no filter is applied.
#Filter="%Target% contains \"LogFile\""

# Formatter string. optional, by default only Tog record message text is written.
Format="[%Timestamp¥]: (%Severity%) ¥Message%"

# File size, in bytes, upon which file rotation will be performed. If not specified, no size-based rotation will be made.
; >

Rotationsize = 1048576

ig '_I"'ime interval, in seconds, upon which file rotation will be performed. See also the RotationTimePoint parameter and the note
elow.
#RotationInterval = 3600

# Time point or a predicate that detects at what moment of time to perform log file rotation, e.g. at midnight
RotationTimePoint= "00:00:00"

# Enables or disables final file rotation on sink destruction, which typically happens on program termination.
EnableFinalRotation = true

# The flag shows whether the sink should be asynchronous
Asynchronous=Ffalse

# Enables automatic stream flush after each log record.
AutoFlush=true

# appends log data to existing file if true, or clears if false
Append=true

# Uncomment the below for logging to console
#[sinks.consale]

#Destination=Console

#Filter="%s5everity% >= warning"
#Format="[%Timestamp%]: (%Severity%) *Messagek"
#autoF Tush=true

By default, the log file is active; DisableLogging = false
(If logging needs to be deactivated, then change to DisableLogging = true)
Default severity level for logging data is “error”; Filter="%Severity% >= error

For a more detailed record, change to Filter="%Severity% >= trace"

To find and view log file

Location: C:\Users\<username>\AppData\Local\Temp\
File: imslog_#####.log

where ##H#H## starts at 00000 and increments with each new log write.
Sort and find by date stamp.
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